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o, you’ve hopefully managed to get your iMac plugged

in, booted up and running like a dream, using the first

part of our Your iMac Handbook. You may even have

followed last issue’s instalment on how to get

online. Now, in part three, we take a look at the

applications you get as standard with your iMac,

straight out of the box.

We take you on a guided tour of what your

iMac’s got to offer you in practical terms. The

first four pages kick off with an in-depth

look at word processing, looking at

everything from opening a new

document to formatting text and using

commands like Cut, Copy and Paste.

Once you’re word processing

perfect, you can move on to

databases and spreadsheets. We

look at each in detail, exploding

all the nasty myths and

making it all as easy as 1-2-3.

We tie things up this month

with a similar look at the

Drawing and Painting

features your iMac has 

to offer. Phew! 
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Your at-a-glance guide to 
the iMac handbook

handbook
In the third instalment of our
indispensable Handbook 
series, we apply ourselves

Word processing

Open a new document

Formatting text

Cut, Copy & Paste

Spreadsheets

Formatting your data

Functions and charts

Databases

Database fields and layouts

Organising your data

Drawing

Drawing shapes

Combining text and
graphics

Painting

Troubleshooting tips

cut-out-and-keep

Huge
user manual

Registering AppleWorks
When you start AppleWorks for

the very first time, you’ll be

asked to enter a registration

number. Don’t worry about this

because your copy will be

registered when you register

your iMac itself. Just leave the

box blank and continue.

NEXT MONTH
We continue with our look at the
applications you get with your 
iMac, including how to fax, play CDs,
DVDs and use Palm Desktop.
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ime was when the only

people who needed to

know how to type were

secretaries. Now

though, many more people may

need to produce regular

reports, correspond with clients

or impress business partners

with neatly-formatted and

composed documents.

At home, we all need to be

able to produce letters for the

bank manager, the insurance

company and even aged aunts

with bad eyesight. The days are

long gone, too, when you could

turn out an acceptable school

report with half a dozen sheets

of foolscap and a ballpoint pen.

The alternative to hand-

written text used to be the

typewriter but computers have

now taken over. With a word

processor, you can correct

mistakes, move text, add pages,

draw diagrams, and change

tabs, all without putting a word

on paper. Take a look at our

diagram if you’re not sure. Word

processors are to typewriters

what the modern family car is

to Stevenson’s Rocket.

So where do you get a word

processor for your iMac? The

answer, for those who hadn’t

realised it already, is that you’ve

already got one. All iMacs come

with AppleWorks, a program

which handles not just word

processing, but spreadsheets,

databases and drawing too. 

We’ll kick off with word

processing, giving you a quick

tour of the jargon, the

techniques and the potential

you have at your fingertips for

producing truly professional-

looking work. Let’s get going.

Whether you need to produce an impressive letter for the bank
manager or a round robin for your mates, this is the answer

Applications

Character
Each letter, punctuation mark or
number in your document is a
character. Spaces and tabs and
are characters too, although you
don’t normally see them.

Font
Times, Chicago and Helvetica are
all fonts, or different designs for
text characters. You can have
heavy, light, condensed and
serif/sans serif fonts.

Paragraph
All the text between two carriage
returns is a paragraph. Remember
that word processors wrap lines
of text automatically, so only use
the Return key when you want to
start a new paragraph.

Jargon
buster
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Word processing

Typewriters versus word processors

One font throughout
Most traditional typewriters only have one font, or

character style. Courier is the traditional typewriter font

Left-align only
Unless you want to do constant mental maths and insert
spaces manually, typewriters can only align text to the left

margin, leaving the right margin ragged

Multiple fonts
You can use any of your iMac’s installed fonts (dozens) for a

range of different text styles

Multiple alignment options
Word processors automatically insert micro-spaces needed
for perfect left, right, centred and justified alignment

Manual carriage returns: You have to 
spot for yourself when the next word
won’t quite fit on the line, and start 
a new line manually

Black and white only!
Unless you’ve got some fancy typewriter
with multicoloured ribbons, you can have
any colour you like as long as it’s black

Copies awkward to make
You either have to use carbon paper
(messy) or use a photocopier (expensive
and/or inconvenient) to make copies of
your work

Minimal styling options
You can underline words for emphasis,

but that’s it

Restricted line spacing
Single-space, double-space or

somewhere in the middle. That’s your lot

Mistakes difficult to fix
Handy with the correction fluid, are you?

You’d better be and you’d better hope the
corrected word is the same length as the

wrong one!

Automatic line breaks
You don’t have to hit the Return key at the
end of each line. Your word processor 
wraps text on to the next line automatically

Print as many copies as you like
You can choose how many copies you
want when you set the document up for
printing, or print them on demand later

Variable line spacing 
You can set the line spacing to adjust
automatically to the size of the text, or set
it to precise values of your own choosing

Use any colour you like! 
If you’ve got a colour inkjet printer, the
world is your oyster (laser printers only

print black and white and shades of grey)

Mistakes easy to fix
If you need to correct a word, delete or

add text, the rest of the text shuffles along
to make space or take up the slack

Bold, italic, underline text styles
Add proper emphasis to your text. These

styles also give you more design flexibility

Still need convincing that your iMac completely thrashes the traditional typewriter in every department? Say no more
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Edit
When you make any changes to a
word processor document or the
text within it, you’re ‘editing’ it.
This includes adding to the
document or changing it in any
way, not just cutting stuff out or
making it shorter.

Tab
AppleWorks 6’s Starting Points
palette has tabs for each of its
sections. These are like pages you
can bring to the front by clicking
on these tabs. Tabbed dialogs
and palettes are used widely in
AppleWorks and other
applications too.

Tab stop
When you hit the Tab key, the
insertion point is moved to the
next tab position, as set by the
markers at the top of the
document window. You can drag
them to new positions, add them
and remove them.

Template
A template is a special kind of
document which you simply use
as the basis for another. It may
have a pre-planned layout and
structure, together with basic 
text which you just type over 
with your own words.

Zoom
When you zoom in on a
document, it’s effectively like
moving closer. Zooming out is like
moving further away. When you’re
zoomed in, you’ll probably need
to use the horizontal scrollbar as
well as the vertical scrollbar to
move around your document as
the whole thing will no longer fit
in the window.

Text wrap
Refers to the way in which text in
a word processor document
automatically flows between page
margins and ‘wraps’ or ‘breaks’ at
the end of each line.

Return
The Return key on your keyboard
is the equivalent of the carriage
return on a typewriter, except
that you don’t have to type it
manually at the end of each line.
You need only use this key when
you want to start a new
paragraph. Clever stuff.

ow do you go about

creating a new

word processor

document? 

The first thing you see

when you start AppleWorks 5 is

the New Document window.

You’re given a list of all the

different document types you

can create, and Word

Processing is right at the top. 

Make sure it’s highlighted

(just click on an item in the list

to highlight it), then click the

OK button to produce a new,

blank word processor

document. See our annotation

to find out what the buttons,

controls and other gadgets do.

You may also have spotted

another option in the New

Document window, namely Use

Assistant or Stationery.

An Assistant is a quick step-

by-step series of questions, and

your answers are used to create

a document customised to your

needs. Stationery consists of

pre-designed Template files

which give you a head-start in

constructing your documents.

Choosing this displays a list

of Assistants and Stationery.

Use the pop-up menu at the top

of the window to view them by

category: Business Finance,

Newsletters and Home

Budgeting, for example.

First things first. Word processing is all very
well but how do you open a new document?

H

Appleworks 5 
versus Appleworks 6
Although they look very

different, AppleWorks 5 and

AppleWorks 6 actually give you

much the same choices when

you start them up.

Version 5’s New Document
window lists the document
types you can create. Press
the Use Assistant or Stationery
button to view a list of
Assistant/Stationery items

AppleWorks 6 replaces this
window with its Starting Points
palette. This lists document
types you can create on its
Basic tab, and has further tabs
for Assistants and Stationery

Your first document

Open a new 
document

Button bar
These buttons offer shortcuts to the most
common options. Take a look at the online help
to find out how to add and remove buttons

Menu bar
Find about every word processing option on the
AppleWorks menus. The Button Bar gives faster

access to the most commonly-used options

Collapse box
Clicking this will
collapse the window
to just its title bar –
click again to restore

Zoom box
Click this to expand
the window to fit the
contents. Click it
again to return it to
its previous size

Window title bar
This displays your
filename. Our is
‘untitled’ as we
haven’t saved it yet

Vertical scrollbar
If your documents are
longer, you’ll need to
use the scroll arrows
or drag the scroll box
to move through your
document

Document window
A grey area means the
window is currently
larger than the page
it’s displaying

Insertion point
This shows you where

the text will appear
when you start typing

Compared to most, AppleWorks word processor documents are very straightforward. But to the uninitiated they can

still appear complex and daunting, so here’s a quick tour to show you what everything does

Page area
Shows the size of the

paper. Set margins
and the page size via

File, Page Setup

Formatting controls
Row of buttons to

set text alignment,
line spacing and

tab stops

Pop-up menus
There are menus 

for text size, style
and more 

Text area
The area of the page

you can type in.
Varies depending on

the margins set 

Zoom controls
Use these to zoom in
and out of document,

or click percentage
figure to open a pop-

up Zoom menu
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e’ve explained

that you can

format the text in

your word

processor in a variety of

different ways, but before you

can do this you need to get the

hang of selecting text.

To select a portion of text,

all you have to do is click at the

start of the text and, with the

mouse button still pressed,

‘drag’ over the text you want to

select, releasing the mouse

button at the end.

Now that your text is

highlighted, you can hit the

Backspace key to delete it all in

one go, or simply start typing

the new text – it will replace the

old text instantly as you type.

Ch-ch-ch-ch-changes

Once you’ve selected your

piece of text, you can also apply

AppleWorks’ various formatting

options to your text.

For a start, try changing the

text size using the Size menu, or

the pop-up menu on the button

bar. Try changing the font – the

Font menu gives you a

WYSIWIG display of the

fonts available. Try out the

options on the Style

menu, too, and note that

AppleWorks offers much

more than

just bold

and italic

options. 

These

formatting options change the

appearance of your text, but

there are further ‘paragraph’

formatting options which alter

the way it’s laid out. See our

diagram below to find out more.

You can also choose these

options via Paragraph option

on the Format menu.

‘Paragraphs’ are important

in word processing. For things

like tab stops, alignment,

indents and leading, they’re

treated as single, indivisible

items. You can use different

fonts, colours, sizes and styles

within a paragraph, but you

can’t mix horizontal alignments,

indents and other paragraph-

wide properties.

Just as colours clash, so do certain text
styles. Read on to learn what’s what…

Applications

WYSIWYG
This acronym stands for ‘what
you see is what you get’. Things
looks the same on screen as
when they’re printed out.

Leading
Leading is a more sophisticated
form of line spacing where you
can specify distances exactly.
These distances are measured in
‘point sizes’, just like text sizes.
Typically, the leading should be
around 20 percent greater than
the text size.

Default
When you create a new
document, AppleWorks uses
standard settings for tab stops,
page sizes, font and so on –
these are known as the program
defaults. You can change the
defaults to suit you.

Point size
Text sizes in word processor
documents are measured in
‘points’. Typically, you might use
12pt (the abbreviation for
‘points’) text in letters and 36pt
text for headlines.

Serif
The small ‘tail’ at the ends of the
characters in some letters. Hence
you get ‘serif ’ fonts like Times
and ‘sans serif ’ (without serifs)
fonts like Helvetica.

Jargon
buster
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The AppleWorks formatting bar

Indents
You drag these

markers to set your
paragraph indents.

The top marker sets
the indent for the first

line, the bottom
marker sets the

indents for the rest

Alignment buttons
Select your text, click on

these buttons to align it to
the left margin, the centre,
the right margin or justify it

Line spacing
Click either side to
increase or reduce the
line spacing, or double
click the box in the
centre to type in a
specific leading value

Selected text
When your text is selected it

will be highlighted like this 

Columns
You can create
multi-column
documents, but we
don’t have the space
to go into this here –
see the online help

You can probably do anything you can think of with a word processor like the one in AppleWorks – you just need

to know where all the features are located. Here’s a quick guide to the most useful

Typical text styles – and
when to use them
Body text

For the main text in letters,

articles and reports, use a font

designed for the job. Helvetica is

OK, but we reckon Times is

easier on the eye. Flashy fonts

will just give you a migraine.

Other ‘body’ fonts include

Garamond and New York.

Headings

Use a thick, heavy font such as

Arial Black or Impact at 24pt or

larger. This will contrast well with

your lighter body text. Contrast

is the key to good design.

Straplines

If your heading needs a sub-

heading, try Times in a larger

size and italicised – between

18pt and 24pt works well and

looks very elegant. Avoid using it

for more than 25 words, though.

Display fonts

Fonts like Textile and Sand are

designed for character, instant

appeal and dramatic statements.

They’re not designed to be easy

to read, which is why they should

only be used for headings.

No-nos

The AppleWorks Style menu has

Shadow, Outline and Underline

options. Don’t use them! All

three are rather tacky effects,

and underlining was only ever

any use on traditional

typewriters where there was no

other way of adding emphasis.

Formatting text

Tab stops
By default, new word processor documents have
tab stops already inserted at default positions.
You can delete and move these tabs stops, and
add your own

Tab buttons
You can create left
tabs, centre tabs, right
tabs and decimal tabs.
Click the chosen tab
type, then click on the
ruler bar below to
place the tab



ven professional

authors seldom get

their words right the

first time around. And

the great thing about word

processors is that you can make

both minor and major changes

easily, before a single word is

even committed to paper.

Minor changes are quite

easy to fix. If you spot your

mistake straightaway, you can

simply use the Backspace key to

delete what you’ve just written,

one character at a time, and

start typing again. Or, if you

only spot it later, you can click

the insertion point at the end

of the offending text, and then

use the Backspace key as before

to type in the correction. The

remainder of the text will then

reflow automatically.

Using the Backspace key is

a pretty slow process, though.

For larger changes, select the

text first as described on the

previous page. Then all you

have to do is start typing your

new text – it’ll overwrite the old

text instantly, and there’s no

need to delete it first.

Now, it may be that there’s

nothing actually wrong with the

words you’ve written, just that

they’re in the wrong place. How

do you move them? 

Try selecting a few words of

text, and then move the mouse

pointer over it. Did you see it

change into a little arrow icon?

This is the drag-and-drop icon,

and it means you can now drag

this text away from its current

location. Try it – a thick,

vertical insertion point bar

moves along underneath the

mouse to indicate that when

you release the mouse button,

the text will be dropped into

that new location.

The traditional method for

moving text around, and the

one that’s still probably the best

for larger amounts of text (drag

and drop can be confusing if

you’re easily muddled) is Cut

and Paste.

It’s a two-step process. You

select the text and then Cut it

via the Edit menu or using the

Command, X keyboard

shortcut. Next, you place the

insertion point where you want

the text to go, and Paste it via

the Edit menu or using the

Command, V shortcut.

Cutting is not the same as

deleting. When you delete text,

it’s gone for good, but when you

Cut it it’s saved to a temporary

memory called the Clipboard.

Be warned, though – the

Clipboard can only store one

item at a time, so if you Cut

anything else before you’ve

Pasted your first item, it’ll be

overwritten and lost for good!

You’ll see on the Edit menu

that you can Copy items as well

as Cut them. With this, the text

is copied to the Clipboard as

before, but it’s also left in its

original location too. These

commands will soon become

like second nature to you.

Once you learn how to Cut, Copy and Paste in AppleWorks, you’ll
wonder how you ever managed without it – in any application

E
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Clipboard
The iMac’s Clipboard doesn’t just
store text. It can also store
images, sounds and other
objects, depending on the type of
program you’re working with.

File type
When you save a document, it’s
stored by default in AppleWorks’
own file format. You can choose
others in the Save dialog, though,
and this is useful if you need to
swap files with people using 
other programs.

Crash
Why should you keep saving your
work then? Because iMacs can
occasionally ‘crash’, that’s why. A
crash is when the whole machine
freezes, and your only option is
to restart it, losing all your
unsaved work in the process.
Crashes aren’t always a sign of
any serious malady – they can
just happen every now and again.

Background printing
Most printers will work in the
background, leaving you to carry
on with your work. They do this
by ‘spooling’ your pages to a
program which feeds them to the
printer at its own speed. It’s a
slower way of doing things but
you can get on with other stuff at
the same time.

Chooser
You’ll find the Chooser on the
Apple menu, and it’s the utility
you use to pick the printer you
want to print to. If you’ve just got
the one printer, you’ll probably
only have to visit the Chooser
once. If you have more than one,
you may sometimes want to swap
between them.

Backspace key
The Backspace key is like the
Delete key but it’s delete
backwards rather than forwards,
It’s a really useful key located in
the top right of the main bulk of
keys on your keyboard.

Command key
The Command is a key you’ll use
all the time when you get to grips
with keyboard shortcuts. It’s the
one with an apple symbol on it
and in fact can also be called the
Apple key.

Cut, Copy & Paste
Saving your work

A new, blank AppleWorks
document will be called

Untitled until you save it as
something else. So, firstly open
the File menu and choose the
Save option. AppleWorks will then
ask you to choose a filename and
a folder to store it in, as in the
next shot. But then what’s that
Save As option for?

Once you’ve saved your
document for the first time,

using the Save command doesn’t
ask you what to call it or where to
save it again – it simply overwrites
the file you’ve already created.
Use Save As if you want to save a
new, separate file to the first –
then you’ll be able to choose a
name and location again

1 2

Nearly all iMac applications,
AppleWorks included, have a

Page Setup option on the File
menu. This is where you tell the
program what paper size,
orientation and scaling options
you use. These vary according to
the model of the printer. Page
Setup options are usually saved
along with your file, so you may
only have to do this once

The second step is to choose
the Print option from the File

menu. Here, you can choose print
quality options, which pages you
want to print, how many copies
you want and so on. Again, these
settings will vary according to the
printer you’re using. When you’re
ready and happy with your
settings, hit the OK button

1
2

Printing your work
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ave you ever written

down a calculation

on the back of an

envelope? Yes, it’s a

crude way of doing things, and

electronic calculators are a lot

faster. But with the back of an

envelope you can at least see

what you’ve done, scrub out

figures if they’re not right and

start again.

Well, a spreadsheet

combines the advantages of

both calculators and envelope

backs! It lets you enter text,

numbers and calculations and,

because it does the sums for

you, eliminates all those mental

maths errors. 

Everything you type in stays

on the screen and is saved

when you save the spreadsheet.

Not only does a spreadsheet

display all your ‘workings’, it

also lets you change any of the

numbers at any time to try out

what-if scenarios.

There’s a myth that

spreadsheets are only used by

accountants and high-flying

financiers. It’s true that if you

do this kind of work you’ll need

spreadsheet tools, but these

same tools are

just as valuable

for smaller jobs

like planning

your household

budget or

working out the

repayments on

your car.

Spreadsheets

are essentially

like pocket

calculators that

never forget the numbers or the

calculations you type in, have a

giant display (much bigger than

your iMac’s screen can show in

one go), and can perform – and

re-perform – any number of

calculations on demand.

A spreadsheet is like a huge

grid, or table, of data. It’s

broken down into rows and

columns, and this produces a

vast grid of ‘cells’. Each cell can

contain text (a label, a title or a

note, for example), numbers

and calculations. Just click on

the cell and start typing.

These calculations are

called formulas, and you type

them in much as you would

type in a calculation on the

keyboard of a pocket calculator.

Type ‘=4*3’, for example, to see

what 4 multiplied by 3 comes

to, or ‘=4.45367*3.11920’. 

(With an AppleWorks

spreadsheet you type the

Equals sign and use the asterisk

key to represent Multiply.

This example just shows

you how similar to calculators

spreadsheets are. In fact,

though, spreadsheets are a lot

more powerful and flexible than

this. Instead of typing numbers

directly into your formulas, you

can type in cell ‘references’.

These are simply the grid 

co-ordinates of a spreadsheet

cell from which you want to

fetch a number.

In our example, then, we’d

type in a formula like ‘=A1*B1’.

We’d put one number in cell

A1, another in B1 and the cell

we typed our formula into

would then display the results

of multiplying them together.

The beauty of doing it this

way is that we can then put

different numbers into these

two cells and our formula will

then instantly re-calculate the

result. Fantastic for serious

number crunching, eh?

There’s lots more you can

do with spreadsheets which

we’ll explore in the next section.

For now, though, if you’re new

to spreadsheets, why not try out

our walkthrough, in the boxout

on the left?

Get to grips with spreadsheets
and make light work of your sums

Applications

Cell
A spreadsheet is a grid made up
of columns and rows, and this
produces a rectangular array of
‘cells’. Each cell is a self-
contained item which can contain
text, numbers or formulas.

Column
The vertical columns in a
spreadsheet are labelled
alphabetically from A to Z and
then, after Z, they go AA, AB,
AC… and so on. The column
letter helps identify the location
of all the cells in that column.

Formula
A formula is a calculation you
type into a spreadsheet cell.
Usually, these act on numbers
stored elsewhere on the
spreadsheet, which are identified
by their cell reference.

Row
Rows travel horizontally across
the spreadsheet and they’re
given numbers. You can select a
whole row by clicking the row
number to the left of the first cell.
Do the same with columns by
clicking on their letter.

Reference
A cell reference is its unique
location on a spreadsheet,
represented by its column letter
and row number, in that order.
Cell B5, for example, will be in
column B, row 5.

Jargon
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Your first spreadsheet
Our sample spreadsheet (shown below) will automatically add VAT to any amount. Not your favourite job, maybe,

but it shows you how easy entering a formula is. Once you’ve mastered this, the world’s your oyster

AppleWorks 6 looks very different to AppleWorks 5,
but for the most part these differences are confined
to the appearance of the Button Bar and toolbar.
Otherwise, spreadsheets work in just the same way

We’ve started with a new,
blank spreadsheet, and

used the first three cells on the
top row to type in labels for the
cells underneath. It’s easy – click
on the cell and type. Labels are
useful to remind you later of how
you’ve set up your spreadsheet

In the cell underneath
Amount, we’ve entered the

number we want to add VAT to.
Again, you just click and type.
Next to it, under VAT, we’ve typed
in ‘1.175’ – this is what you have
to multiply an amount by when
you add VAT (17.5 percent)

Now we enter our formula in
the cell under Total. We type

‘=’, click on the amount, then
click ‘*’, click on the VAT number
and hit Return. Note how the
formula we’ve entered is
displayed in the Entry Bar above
when we click on the cell

Spreadsheets

1 2 3



ow, there’s nothing

wrong with the

calculation we

carried out in the

previous section but, since

we’re working with money, we

need to identify the fact so that

AppleWorks can automatically

format and display our figures

in the correct way.

So, select the cell, and click

the Currency button on the

Button Bar. AppleWorks will

add a £ sign before the amount

and add two

digits to

represent

pence.

This will

help us when

calculations

leave us with

far too many

decimal places.

We don’t deal

in fractions of

pence, after all.

Clicking on

Currency will

round the

amount to the

nearest whole

penny. Apple-

Works is still

storing the

amount with all

decimal places,

just not

displaying

them all. 

The Currency format is just

one of the special Number

formats you can set up in

AppleWorks. To see the full list

of what’s possible, choose

Number from the Format menu.

See our annotated diagram to

find out what each one does

and when you’d use them. 

Depending on the size of

the numbers you’re dealing

with, something else may

happen when you enter them or

carry out calculations. Instead

of seeing figures in your cells,

you may just see a row of hash

(#) symbols. (Please note that

this doesn’t happen with text,

only with numbers).

Don’t panic! This simply

means that the row is not

currently wide enough to

accommodate the number. You

can fix this with very little fuss

by moving the mouse pointer

up to the column headings, and

then dragging the line

separating one column from

the next to resize the column.

You can also change the

height of individual rows by

dragging the dividers between

the row numbers. And you’ll

need to do this if you change

the size of the text and/or

numbers in your cells. This is

very easy to do. You just click on

a cell to select it, then choose

the font, size and style you want

from the Format menu.

As you’ll have spotted from

this Format menu, you can also

change the colour of the cell

contents. And that’s not the

only way you can add colour 

to your

spreadsheets.

True colours

First, make sure

the toolbar is

displayed, either

via the Window

menu or the

little button

towards the

bottom left of

the document

window. Now,

with a cell

selected, try

choosing one of

the colours on

the pop-up Fill

Colour palette.

Remember it

doesn’t have to

horribly garish

to make it more

interesting. 

You can

change the horizontal

alignment of cell contents too.

By default, text is aligned to the

left, and numbers are aligned to

the right. But if you want to

change this, select the cell or

cells, then click on the

appropriate alignment button

on the Button Bar.

Now you’ve learnt the basic theory of a
spreadsheet, here’s a bit more detail

N
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Cell range
You select a single cell by clicking
it, but you can select a range of
cells by dragging across them.
Drag diagonally to select both
rows and columns of cells.

Border
Using the Border option on the
Format menu gives you the choice
of outlining the selected cell or
cells, or adding lines to one or
more of the sides. It’s a useful way
of highlighting cells, although
using colour is generally a more
effective method.

Entry Bar
When a cell contains raw text or
numbers, that’s what you see
when you view the spreadsheet.
When it contains a formula, you
only see the result, not the
formula. To view or edit the
formula, click on the cell – the
formula can then be edited in the
Entry Bar at the top.

Rounding
When you choose a precision
level in the Number dialog,
AppleWorks rounds numbers up
or down for display, depending
on which whole digit is nearest.

Function
AppleWorks doesn’t expect you
to do all the maths yourself. It
provides a number of pre-
designed Functions for
specialised tasks. These are dealt
with in the next section.

Colour palette
Just like an
artist’s
palette, this
one shows
you the
whole range
of  colours
you can
choose from.
Don’t go
mad but a
few well-placed colours in a
spreadsheets will stop your
readers from dropping off while
reading it!

Formatting 
your data

Version 6 uses its Accents palette
to apply colour to cells, and its
Number dialog uses a menu for
choosing formats. Other than that
it’s the same as version 5

Number formats

Time formats
Lets you do
calculations
with times,
and display
the results of
time-based
functions

Precision
Lets you choose
how many decimal
places are shown,
al though
calculations still
use all of them

Fixed
Use this for non-
cash numbers
where you want to
control how many
decimal places are
displayed

Scientific
Complex stuff! If
you don’t know

what it is, you 
don’t need it!

Percent
Type percents

as decimals
(50 percent is
0.5), but this

format shows
them as

percentages

Currency
Use this for

showing and
working with
money – see

the main text

General
This is the default
Number format. Not
for cash sums and
other specifics

Date formats
Lets you do calculations
with dates – for example,
adding 30 days to a date
for an invoicing system

Whether you’re talking percentages, or pounds sterling, the

Number formats in spreadsheets are useful
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e mentioned

spreadsheet

functions in the

previous section,

and how they can be used for

more complex and specialised

tasks. A function either

automates a more complex

conversion process or

calculation, or generates

information, such as the

current time or date.

One of the simplest is the

Sum function. You can use this

to add up a column of figures,

and it’s an example of how

functions can save you time. 

In this instance, the

alternative would be to

manually type in a formula

adding cell 1, cell 2, cell 3 and

so on. To use the Sum function,

select all the cells in your

column of figures, plus the

blank cell directly underneath.

Then just hit the Sum button

on the Button Bar!

The Sum function gets its

own button because it’s such a

commonly-used

one, but you can

browse the full

range of

AppleWorks

functions by

clicking the

Paste Function

button (the FX

button) on the Entry Bar.

There are dozens of

functions here, all arranged by

broad categories. To find out

what each one does, look them

up in the online help.

Nearly all of these functions

have one thing in common,

namely arguments or

parameters. For example, if you

want to Sum a column of

figures, you need to identify the

cells that contain these figures

and this is an argument.

Despite the confusing jargon,

it’s quite simple.

When you paste a function

into a cell, the arguments you

need to enter are displayed in

brackets. Let’s take another

example. Let’s say you want to

work out the average of a

column of figures. 

Select the blank cell

underneath the column, click

the Paste Function button and

choose the Statistical category.

You’ll find the Average function

near the top. 

Once it’s pasted in, you’ll

need to tell it which numbers to

average, so select everything

inside the function’s brackets in

the Entry Bar, then drag over

the cells in your column of

figures. This enters them as a

cell ‘range’ – it’s a shortcut

that’s quicker than entering

them all individually when

they’re in a block like this.

Now all you need to do is

hit Return or click the green

Tick button on the Entry Bar.

Now, imagine you’re

working on your household

budget and you’ve already

entered a list of the things you

spend money on in an average

month, and the amounts you

spend. You can use the Sum

function to calculate a total, but

maybe you’re looking for some

rather more meaningful

insights than just this raw

figure. Maybe you want to get

some idea of where your money

is going, not just how much of it

is going out of the door!

For this you need a chart

and as if by magic we have the

the very thing on the left…

Functions and charts can tackle
even the trickiest home accounts

Applications

Argument
Before a function can work, you
need to tell it what number or
numbers it must act on, either by
typing them into the spreadsheet
or by quoting a cell reference
where they’re stored. These
numbers are called the 
function’s arguments.

Axis
Charts have horizontal and
vertical axes, and you click on the
Axes button in AppleWorks’
Chart Options dialog to choose
their labels, their ‘tick’ spacing
and other settings.

Labels
In our walkthrough, AppleWorks
generated its heading from the
heading we typed into the
spreadsheet itself. However, you
can also create your own via the
Chart Options dialog.

Legend
This is the ‘key’ that matches the
colour of the pie segments or
other chart objects (it depends
on the chart type) with the data
it represents. You can choose
whether or not you want to
display the Legend.

Parameter
Parameter is another word for
‘argument’. Different spreadsheet
programs may use different
terminology, but it’s the same
thing so don’t worry!

Jargon
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To insert a function, click FX on the toolbar. They are
organised into categories and, once they’re pasted
in, you simply replace the arguments in brackets
with your own numbers or cell references

Functions and
charts

Creating a chart
When was the last time you created a graph? Back in school in a maths lesson, we reckon! Well, leave the

protractors, compasses and crayons aside, and fire up that spreadsheet program!

Here are our monthly
household outgoings. At the

top we’ve got a heading and in
the two columns we’ve listed
each item and the amount we
spend. Now select both columns
(and the title) and choose Make
Chart from the Options menu

As you can see, AppleWorks
offers a wide variety of chart

types, and you choose the one
best suited to your needs. In our
case, that’s a Pie chart, which
displays graphically the
proportions of each item which
make up the total

And that’s all. Just click on
OK and the chart is created.

AppleWorks has automatically
used our labels as chart labels,
and our heading as the chart
heading (make sure there’s no
gap between the heading and
the columns)

1 2 3



opefully, over the

past three pages

we’ve convinced

you of how useful

spreadsheets are. 

That’s nothing, though,

compared to what databases

can do. And, in AppleWorks,

you’ve got one of the best

database programs you can get

your hands on, certainly as far

as light office or school/home

use is concerned.

The best way to understand

databases is to think of those

old Rolodex cards or boxes of

index cards. Each card is the

same size and (if you’re at all

organised) laid out in the same

way. On the top line you might

have a person’s name, on the

next line their company name,

then their phone number,

address and other information.

You can store a lot more in

an AppleWorks database than

just addresses, but it’s a good

example to start with because

it’s something we all find useful

from time to time.

When you create a

database, each record in the

database is equivalent to one of

your old index cards. And each

line or item of information on

those cards equates to a field in

a database.

These fields are the first

thing you set up when you

create a new AppleWorks

database, and to see how it’s

done, and how to use your new

database, follow our six-step

walkthrough below.

This is only the start, and

over the following two pages

we’ll show you how you can

make your database look and

work like a polished,

professional application. You

may find yourself hooked and

making high-powered

‘relational’ databases. Here the

data may be stored in several

different files which are linked

together. The idea is that

information is stored in one file

that can be accessed by many

others – there’s only one lot of

data to maintain and update.

The word ‘database’ may be enough to bring you out in a rash,
but hold on! It can be simple and can get you organised in a jiffy

H

Databases
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Record
Think of database records as
identically designed index cards
in a traditional filing system. Each
card contains the same items of
data written in the same place.

Field
Think about how you split your
data into individual fields. The
same fields will appear in the
same place on each record.

Flat file database
Where data is stored in a single
file, or document, and is
completely self-contained –
specifically, it can’t look up data
from other databases. 

Filter/Find
AppleWorks has a Find mode for
locating records that match your
criteria, but other programs may
refer to this as a Filter.

Creating an address database
Fed up of trying to find your friends’ addresses twice a year on birthdays and at Christmas? Well, now you can chuck out your scraps of paper and sort

your life out! A simple database will get you organised in no time!

Choose Database in the New Document
window, and you’ll be asked to do is set

up your database fields. Just type in a name
and press the Create button

1 To add a new record, choose New Record
from the Edit menu or hit Command, R.

Type in the next lot of data as before, with the
new record appearing directly under the first

3When you’ve added all the fields you
need, click Done. This displays your

database in Browse mode where you can just
click on a field and type in the data

2

How do you find people later? Choose
Find from the Layout menu to display a

form where you can type a name into the Last
name field, for example, then hit Return

4 Show all your records again via the Show
All Records option on the Organise menu.

Sort them alphabetically by first name, last
name or any other field using Sort Records

6Sometimes, there’ll be more than one
match. Sort using the navigational tool on

the toolbar. Click the Top page to go back
through records, the Bottom one to go forward

5
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n the last bit we set up a

simple database using

AppleWorks’ default field

types. These are general

purpose Text fields which can

store any type of information,

whether it’s text or numbers or

both. You may never need to

use more specialised, type of

field but they’re there if you

want. You’ll find them in the

pop-up Field type menu in the

Define Database Fields window. 

Number

Use this field type if you’re

storing numbers and you want

to use them to sort your records

numerically. If you use the Text

format, then 11 will precede 2

as it starts with a 1. You also

need Number fields if you want

to carry out calculations.

Date

If you’re storing dates and need

them sorted in the correct

chronological order rather

than alphabetically (you don’t

want April before January, do

you?) you need to use this field

format. You also get a choice of

how the date is presented

(mm/dd/yy, month/date etc).

Time

The same applies to storing

times as dates and numbers.

Sorts and calculations will only

be carried out correctly if you

use the right format.

Name

This is useful for people’s full

names because it sorts them

according to their surname

rather than their first names.

Pop-up menu

If you want to offer a simple list

of options rather than a blank

field, use this format. You

define the list of entries you or

your users can choose.

Radio buttons

These are like the radio buttons

in windows and dialogs – you

set up a list of alternatives and

users click the button alongside

the one they want to pick.

Checkbox

Checkboxes are like radio

buttons, except that you can

click on more than one box.

They’re useful for ticking off

one or more items on a list.

Serial number

If you’re using your database to

store invoices, stock items or

CDs in your music collection,

you can use this field type to

automatically assign each

record with a serial number.

Value list

This works in the same way as a

pop-up menu, except that you

click on the field to open a

scrolling box instead of a menu.

Multimedia

You can paste pictures and even

QuickTime movies into

Multimedia fields.

Record info

These fields can be useful if you

want to store automatically-

generated information, like the

current date or time or a name.

Calculation

Bet you didn’t know that

databases can do calculations

like spreadsheets can! You type

a formula into a Calculation

field, and apply it to numbers

stored in other fields.

Summary

A special type of calculation

field that can produce totals or

subtotals for a while list of

records. You use Summary

fields in ‘Summary’ layout parts.

Applications
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You can use the standard layout generated by AppleWorks when you create a new database, but it’s not exciting to

look at. You can change it by switching to Layout via the Layout menu. This displays the AppleWorks drawing tools,

if they’re not already visible. Our diagram will help you learn what the different layout parts do.

A simple database like the one we created in the last bit is all very
well but you may want to progress to something more complex

I

Database layout

Header
This area is shown at the top of
every page. We’ve used it to type
in a title for our database. (Use
the Insert Part command on the
Layout menu)

Body
This is where all the database
fields you define will appear

Summary
This is a special layout part used
for summarising your records.
Here we’ve used it to calculate
the total value of all the items in
our stock database

Footer
Effectively, the opposite of a
Header! Again, you use it to
place logos or other information
that you want on every page,
this time at the bottom

Layout grid
This grid of dotted lines helps
you line fields and field titles up
while designing your layout

Layout part tabs
Drag these tabs up or down to
increase or reduce the size of
the relevant layout part

Drawing tools
Use these to move fields and
their titles around, draw shapes,
change fonts, choose colours
and make your layouts look as
exciting and dynamic as you like.
There’s more on the drawing
tools in a later section

Database fields
and layoutsAutogrid

By default, in Layout mode all
objects are ‘snapped’ or locked
to the layout grid. This can be a
nuisance if you’re trying to align
things carefully, so you can
switch off this Autogrid via the
Options menu.

Browse
There are two main modes for
working on your database –
Layout mode, where you’re
adjusting its design, and Browse
mode, where you’re entering and
examining your data.

Function
You can use spreadsheet-style
Functions in Calculation fields.
For example, in our database we
used the Sum function to total up
the value of all our stock items.

List
There is another way of
examining large numbers of
records at the same time, and
that’s by using the List option on
the Layout menu. This displays
your records as single rows of
data, with the field names
running across the top.

Sub-summary
A special type of summary which
can subtotal (for example) sets of
records. You might use it to sort
all your invoices and work out the
total amount owed you by each
of your customers.
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Export/Import
You don’t have to type all your
data into an AppleWorks
database manually if you’ve
already got it stored in another
program. Most programs will
export ‘delimited’ text files, 
and AppleWorks is able to 
open these directly.

Forms/Lists
In database terminology, a Form 
is a layout which displays one
single record at a time, while 
a List displays them one per 
row, with the field names as
column headings.

Inserting fields
When you create a new layout
you can choose which of your
database’s fields are displayed 
in it. You should use Insert Field
on the Layout menu. Note that
inserting a field is not the same as
defining one.

Match records
This is another option on the
Organise menu, and it lets you
carry out more complex and
sophisticated searches that
would otherwise require
numerous Finds. One for more
advanced users only.

Report
Reports are printed documents
containing specific records 
(using a named Search) in a
specific order (via a named Sort).
For example, you might want to
print a list of widget sales in 
order of value.

nce you’ve got your

database up and

running, you’ll be

looking for quick

ways to find your information.

We touched briefly on Sorting

and Finding data just a couple

of pages back, but now it’s time

for a closer look.

In particular, you should

check the vertical toolbar to

the left of your database

window. In Layout mode this

displays the AppleWorks

drawing tools, but in Browse

mode it displays a card index-

style navigation tool at the top

and, underneath that, four little

pop-up buttons.

These handle (in clockwise

order, starting from the top

left), Layouts, Searchs, Reports

and Sorts. We’ll leave Reports

for now because they’re used

for specialised printouts, but

knowing how to use the

Layouts, Searches and Sorts will

help you tremendously.

Field trip

We looked at Layouts briefly in

the last section, and there are

two things to note here. 

First, you can create as

many different layouts as you

like. And for each one, you can

choose the fields you want to

include – this lets you produce

simple layouts for day-to-day

data browsing, for example, and

more complex layouts for in-

depth information. 

Second, all the layouts you

create via the Layout menu are

displayed in this pop-up, and

vice versa. This button is simply

a shortcut way of getting to

them all.

The Search pop-up menu is

even more useful. Normally,

when you do a Sort from the

Organise menu, your search

criteria aren’t stored

permanently. So, for example if

you want to look up ‘widgets’,

you’ll have to go into Find mode

and type it in each time you

want to do it. 

However, if you create a

new Search via the pop-up

toolbar, you only have to do it

the one time. From then on,

your Search criteria are saved

and listed on the pop-up menu

each time.

The same applies to Sorts. 

If you apply a Sort via the

Organise menu, your choices

will not be saved. However, if

you create a new Sort via this

pop-up then it will be saved 

on the menu.

The Layouts, Searches and

Sorts you create are saved with

your document by the way so,

with a bit of planning, you 

can make your data infinitely

more accessible.

O

There’s even more to your new database
then you realised. You can choose to find
data by numerous means

Organising
your data

Creating a Search
You can specify different ways of searching. Brilliant for getting to relevant information at top speed

To create and save a
Search, look for the pop-up

menus on the toolbar to the left
of the window in Browse mode,
click on Search and choose New
Search from the pop-up menu

You’ll be asked to give your
new Search a name. This is

the name which will appear on
the pop-up menu once you’ve
saved the search. Choosing this
will apply the Search instantly

First, though, you’ve got to
define the Search criteria.

Here we’re just entering ‘widget’
in the Name field. This will
search out all records containing
‘widget’ in this field

1 2 3

Creating a Sort
You can choose to sort your

items in all sorts of ways

As with Searches, any
Sorts you create from the

toolbar pop-up will be added
to the menu and saved with
your document. Choosing
New Sort opens the Sort
Records’ dialog…

1

Here you can enter a
name for your new Sort

and then choose which field
you want to sort by selecting
it from the list on the left and
clicking the Move button

2

Note that you can create
both ‘ascending’ and

‘descending’ Sorts. We want
to list our stock items with the
most valuable first, so we’re
choosing a ‘descending’ sort.

3
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e’ve mentioned

the drawing tools

already in the

database section,

and they can be used either to

produce illustrations to go with

existing documents (they can

be used in word processor

documents and spreadsheets

too), or you can create

standalone drawing documents.

AppleWorks can create

paintings, but these are very

different to drawings. Paintings

are bitmap images, made up of

individual microscopic pixels.

Drawings, on the other hand

are made up of much larger

shapes that you can carry on

editing individually.

Rubber band

Think of shapes as rubber

bands which you can keep

expanding, contracting,

reshaping and moving around.

Shapes can also be ‘filled’ with a

colour, gradient or pattern.

Photos, whether scanned in

or taken with a digital camera,

are bitmaps – there’s no way

you could reproduce the

complex shading and detail of

real-life objects with drawings.

Drawings look more

artificial, but that doesn’t

always matter and they’re a lot

more convenient to work with.

In addition, it doesn’t take long

to learn how to use these tools

to create quite sophisticated

graphic effects.

You can use the drawing

tools, as we’ve said, in word

processor and spreadsheet

documents and databases (in

Layout mode). If they aren’t

visible to the left of the window,

click the tiny button to the

bottom left of the window,

fourth from the left (to the right

of the zooming in button). 

Then see our rather

complicated annotated diagram

below to discover what

everything does.

Applications

Bézier
Most drawing applications talk of
Bézier shapes (AppleWorks’
bezigons are just a variant).
Bézier shapes are made up of
curves and corners defined by
‘nodes’ which you can adjust.

Polygon
AppleWorks creates both
‘regular’ and ‘irregular’ polygons.
They’re simply shapes made up
of straight-line sections which are
joined at ‘nodes’.

Gradient
A smooth transition from one
colour to another. AppleWorks
supplies pre-designed gradients,
but you can create your own.

Texture
Textures are bitmap patterns
which make drawings lifelike and
colourful and, as with gradients,
you can make your own.

Handle
A handle is simply a device you
can drag on to change the size of
an object (in the case of corner
handles) or its shape (as with
polygon or bezigon nodes).

Jargon
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So you might not be Picasso, but who says you can’t have a bash
at creating some groovy graphics? AppleWorks has just the thing

W

Drawing

Drawing tools

AppleWorks 6’s drawing tools
work in much the same way, 
but colours, lines and fills are
displayed in clusters in the 
tabbed Accents palette 

Pointer
Select objects for
moving (by dragging

from the centre) or resizing (by
dragging the corner handles)

Spreadsheet tool
Drag out a rectangle
with this to create a

spreadsheet frame within the
current document

Line tool
Use this to create
straight lines

Rounded rectangle
Rectangles with
rounded corners

(double click on rectangles to
change the corner radius)

Arc tool
Produces one-
quarter circle/ellipse

segments

Bezigon tool
Produce curved
shapes with control

nodes – there’s more on how to
adjust these on the next page

Current line
Shows how the
current line settings

will appear

Current fill
Shows the fill
currently selected

Line thickness and
arrowheads
Control line thickness,

or ‘weight’ and apply arrows to
one or both ends

Freehand tool
Just drag to produce
freehand lines

Regular polygon tool
Pentagons, hexagons,
octagons – select the

tool then choose the number of
sides you want via Edit menu

Fill buttons
Use these to open pop-up
palettes where you can

choose from a range of solid
colours, patterns, gradients

Line fill and pattern
These two buttons
control the line’s colour

and any pattern used

Eyedropper tool
Click shape to pick up
its fill and line

properties then Command, click
on another shape to apply them

Text tool
Use this to drag out
text boxes which you

can simply type straight into

Paint tool
Drag out a rectangle
with this to create a

frame you can paint in

Rectangle tool
Creates rectangles
or, if you hold down

the Shift key, squares

Oval tool
This creates ellipses
or, if you hold down

Shift, circles

Polygon tool
Click to start shape,
move pointer and click

to create corner, click again to
create the next corner etc

Here we’ve chopped up the drawing tool palette so you can easily see what each and every tool does.



he quick tour of the

AppleWorks drawing

tools we gave you on

the last page will help

you understand some of the

basic things you can do with

this program, but there’s still no

substitute for trying them out

for yourself. That’s why we’ve

created a six-step walkthrough.

Why not have a go at it? 

It’s ideal as a quick and easy

introduction you can complete

in minutes. However, there’s a

lot more to discover in

AppleWorks once you’ve

managed these basics. 

For example, many of the

pictures you create will consist

of various separate shapes. If

you needed to move the

illustration around, you

wouldn’t want to have to move

and re-align each shape within

it, would you?

The solution to this

problem is to select all the

shapes that make up your

illustration and choose Group

from the Arrange menu. Once

you’ve done that you’ll be able

to select and move the

illustration as a single item –

and you can also Ungroup the

shapes again later if you find

you need to.

And, while we’ve created a

simple irregular polygon in our

walkthrough on the right, we

haven’t shown you how to edit

its nodes – we’ll save that for

the next section.

Take the time to experiment

and browse the online help and

you’ll discover just how

versatile the AppleWorks

drawing tools are. 

What’s more, they’re the

perfect introduction to more

powerful standalone drawing

programs because they all use

the same concepts – lines, fills,

curve editing, stacking order

and so on.

T

Drawing shapes
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Marquee
There are two ways of selecting
more than one object at a time.
One is to select the first, then
hold down Shift and select the
second. The other is to use the
Pointer tool to drag a dotted
rectangle, or ‘marquee’ around
the objects you want to select.

Reshape
Irregular polygons or bezigons
can be reshaped. You’ll find this
option on the Arrange menu and
it lets you move the individual
nodes or, in the case of bezigons,
it allows you to change the
curvature. There’s more on
reshaping in the next section of
this Handbook.

Rotate
You can rotate shapes once
you’ve created them by choosing
Rotate or Free Rotate from the
Arrange menu. You can even
rotate text frames.

Pretty as a picture
The Drawing program can help with lots of jobs, from creating greetings cards, to designing logos for business

cards and letters. It also good for kids: like crayons but a lot less mess

It only takes a few moments
to create colourful diagrams

and illustrations, and we’ll start
our Summer sun picture by
drawing a circle to represent the
sun. Holding down the Shift key
keeps it circular as you drag

AppleWorks 6’s drawing tools look different to those in AppleWorks 5, but
looks can be deceptive. Yes, the tool icons are chunkier but they do the
same things. The tools at the bottom are for paintings. In AppleWorks 6
the two sets of tools are displayed at the same time, though the painting
tools are greyed out (disabled) when you’re working on drawings

By default, shapes are
created with a 1pt thick line

and a white fill. We don’t want an
outline at all, so we select None
from the line width pop-up on the
toolbar. Next, pick a yellow from
the fill colour pop-up

We’ll add cartoon-style rays
for our sun, and for this we’ll

use the irregular polygon too. We
can point and click to create a
start shape around the sun,
clicking back on our start point
once we’ve gone right around

21 3

Now, for our sun’s rays,
we’ve removed the line

again, and this time chosen a
lighter yellow. The problem is,
though, that the rays now cover
the sun. We can sort this out
using the Move to Back option on
the Arrange menu

There are two more things
to do. First, we’ll create a

blue sky background with a
rectangle shape and a white-to-
blue gradient from the gradient
fill pop-up, moving it to the back
once we’ve created it, as we did
with the sun’s rays

Finally, we’ll add our
Summer sun text by clicking

the text tool and dragging to
create a text frame and then
typing in the words. We can then
choose a font, size and colour via
the pop-up menus on the button
bar, above

4 5 6

Here we look at a few more features of the Drawing program and
show you how to create something pretty in double-quick time
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ne of the keys to

AppleWorks’

versatility is the

way it can combine

text and graphics. In particular,

the level of formatting control

you have over text placed in

boxes, or Frames.

Indeed, AppleWorks text

boxes work like mini word-

processors and, while you can

make changes to fonts, colours

and so on by selecting the box

and using the pop-ups on the

Button bar, you can edit words

and paragraphs by clicking on a

text box a second time. You’ll

find you can select text as easily

as if you were word processing.

And, just to prove it, open

the Window menu and choose

Show Rulers. Now, whenever

you click twice on a text box,

you’ll find you can set tab stops,

indents, line spacing and more.

Click once to move or resize

the box or apply global styles to

its contents; click twice to edit

the text. This applies to paint

and spreadsheet frames, too.

This gives you a choice

when you need illustrated

documents – you can use the

word processor, and use the

drawing tools in documents, or

create a drawing document and

put your text in boxes.

In both cases, you’ll want

the text in your documents to

run around the pictures and

not behind them or on top of

them, and you do this using text

wrap. Try opening a word

document, for example, then

displaying the drawing tools

(Window menu) and drawing a

circle on top of your text. It

covers it up, doesn’t it?

Select the circle and pick

Text Wrap from the Options

menu. Pick Irregular, leave the

Gutter set to its default and

click OK. The text flows around

the circle and not behind it.

Choosing an Irregular wrap

gets the text to follow the shape

of your graphic, while choosing

Regular makes it follow a

rectangular boundary. Regular

is fine for imported photos.

Now, if you’re attempting

this in a drawing document, it’s

not going to work. Text in boxes

will lie over or behind any

shapes you draw, no matter how

you fiddle with their text wraps.

Unless you switch on Frame

Links from the Options menu…

Wrap it up

Something interesting now

happens to your text boxes. Text

wrap now works in the same way

as it does in word processor

documents, but you’ll also spot

a downwards-pointing arrow in

a box at the bottom of the

frame. This arrow turns red if

you’ve got overflowing text. 

Click the arrow, drag out

another box and the text will

flow into this. If you change the

size of the first box, or add more

text, it reflows to the linked box.

Applications

Frame
AppleWorks’ Frames let you
insert different document types
in a single document. For
example, you can insert a
spreadsheet Frame in a drawing 
in order to present some
tabulated data.

Frame linking
This is a powerful option in
AppleWorks for linking text
frames (or ‘boxes’) so that text
flows from one to another. It’s
also possible to link paint and
spreadsheet frames, though this
can get confusing.

Inline graphic
Also called ‘anchored graphics’,
inline graphics are embedded in
the text, and reflow when the text
reflows. When you paste a picture
into an AppleWorks word
processor document, it’s
anchored. To create a ‘floating’
graphic, click on the Pointer tool
before you paste it in.

Reflow
When you change the margins in
a word processor document, or
add a graphic with text wrap
switched on, the text ‘reflows’ in
order to accommodate the
different line lengths. Be careful
with text boxes when frame
linking is switched on, since
reflow from changing the box 
size or wrapping the text 
around graphics can lead to 
text ‘overflow’ at the bottom 
of the box.

Jargon
buster
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You can combine text and pictures on the same page, like we do
all the time in Your iMac. It brightens things up a little 

O

Combining text
and graphics

Layout tips
Create logos using a mixture of

drawn shapes and text frames,

grouping them so they can be

moved around as single items.

You can add photos by

opening them in AppleWorks

then copying them into your

documents. Open them as

Drawings, though (see the

Document Type pop-up in the

Open dialog), as this will make

them easy to resize in documents.

Paintings (the default type) are

harder to resize later on.

Use word processor

documents where the text is the

main content, and drawings

where it’s the layout that’s

important. You can create text

frames in a word processor

document by choosing the Text

tool and holding down the Alt key

as you drag.

Reshaping bezigons

In the previous section we
promised we’d demonstrate

how to reshape polygons and
bezigons. We’ll start by using the
bezigon tool to (attempt!) to draw
a cloud. Mmm… too ‘curvy’, isn’t
it? So we choose Reshape from
the Arrange menu

You’ll spot that the shape
now displays the nodes we

created with the bezigon tool. To
change a node from a curve to a
sharp corner, click on it (or Shift,
click to select more than one)
and choose Unsmooth from the
Edit menu

This gives you the sharp
‘corner’ nodes you get if you

use the Irregular Polygon tool.
You can move these and curved
nodes just by dragging them.
With curved, ‘bezigon’ nodes,
though, you get a pair of handles
for adjusting their curvature

1 2 3
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GIF
A file format designed for Web
graphics with a limited range of
colours, like company logos, for
example. It combines small file
sizes with high quality.

JPEG
A compressed file format which
produces much smaller image files
without greatly sacrificing any
levels of quality. JPEG is the
standard format for photos on
the Web and also images taken by
digital cameras.

Layer
Many image-editing programs
(though not AppleWorks) let you
build up images in Layers which
you can edit individually. They’re
just transparent sheets which you
can paint on and superimpose on
each other in a stack.

Magic wand
The wand is AppleWorks’ third
selection tool. Use this to select
areas of the same colour, like
single-coloured backgrounds or
objects. Your selection essentially
‘spreads out’ until it meets
another colour.

Resolution
The number of pixels per inch
displayed in a bitmap, or paint
image. You can create a higher
effective resolution by shrinking
the image so pixels are smaller.
With inkjets you need resolutions
of 200dpi or higher to stop pixels
becoming visible.

aint packages fall into

two main categories:

image-editing and

painting. Image-

editing means opening photos

taken with a digital camera or

scanned in from a print, and

then correcting brightness and

contrast, removing colour casts

and blemishes and maybe

resizing them for use in your

documents or Web pages.

Firstly, we have to say that

AppleWorks paint tools aren’t

really up to this! There’s little

you can do to tweak photos, and

for this you need a program like

Adobe PhotoDeluxe or Kai’s

Photo Soap. Just about all

colour printers, digital cameras

and scanners come with some

kind of image-editing software.

Graphics for the Web

AppleWorks paint files are good

for creating basic Web graphics

or for amateur artists to dabble

about with though. Click the

Brush tool, choosing a colour

from one of the Fill pop-ups

and splashing it on screen. If

the brush is the wrong size,

double click the Brush tool.

This opens a window where you

can choose from a range of

brush sizes and shapes.

Once you’ve painted a

stroke, it becomes a permanent

part of your canvas, so how do

you edit, copy or move parts of

your pictures? For this, you

need the rectangular selection

tool (which looks like a box with

a dashed outline) or the

freehand lasso tool alongside,

both of which are about

halfway down the tool palette.

Benefit section

So paint documents are less

convenient to work with, but

they have other advantages. You

can create artistic effects which

are impossible otherwise. By

default, your ‘paint’ is opaque

and covers things beneath. But

if you take a closer look at the

Brush Shape window you get by

double clicking the Brush tool,

you’ll see an Effects menu. Try

Tint instead of Normal. You’ll

find your paint is semi-

transparent as you apply it, and

you can use repeated

brushstrokes to build up colour.

And if you want to soften

some of your edges and strokes,

choose Blend from this same

pop-up menu. This time, you

don’t apply any colour, but you

can brush over existing areas to

smudge, or soften them.

As well as the Brush, Bucket

and selection tools, AppleWorks

Paint documents also appear to

offer the same tools that you

find in drawings. They do

indeed work in much the same

way, but with a crucial

difference. As soon as you’ve

completed the shape (or text

frame) it becomes part of the

image, a pattern of pixels rather

than a separate shape you can

carry on editing.

Don’t be afraid to

experiment! AppleWorks

drawings are easy to work with,

but they are a bit clinical.

Paintings are a lot more fun for

messing around, and remember

that you can rub out anything

that goes wrong using the

eraser tool, or simply by

painting over it with white

paint. Try doing that in real life!

The Paint package in AppleWorks is less
complex but still needs an introduction

Painting

The Paint tools in AppleWorks
may look different, thanks to the
new, chunkier interface, but they
work in the same way. Double
click the Brush tool to change the
brush size, shape and behaviour

P

Resolution and depth
If you paste a paint image into a

word processor document, it’ll

appear in its own frame. If you

click twice on the frame you’ll find

you can edit the painting again. 

While individual pixels may

not be visible on-screen, if you

print it out on an inkjet, they will

become apparent as printers

produce sharper detail. Your

pictures need more ‘resolution’

or more pixels per inch. 

So open the Format menu in

your Paint document, choose

Resolution and Depth and set it

to 288dpi. This makes the

picture smaller, so do it before

you paint. You’ll probably need

to create larger documents in the

first place, too (Format menu,

Document option).  

Handling selections

In paintings, you’re dealing
with a pattern of pixels

rather than separate objects. In
order to move or edit part of your
image, you need to mark out the
area you want to alter using the
selection tools. This can take a
little practice!

Once you’ve selected an
area of your image, the

mouse pointer changes to an
arrow when you move it over the
selection, and you can drag it to
a new location. Note that when
you click outside the selection,
the move is permanent

You can apply special
effects to selected areas –

you’ll find a selection on the
Transform menu. Or you can
copy the selection and paste it
into a word processor document,
a drawing or a spreadsheet as a
Paint frame

1 2 3
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here’s not much that

can go wrong in

AppleWorks that the

online help can’t sort

out. Basically, you learn by

doing things, and the more

experience you gain, the more

obvious it all becomes.

However, that’s not much

consolation if you’re just

starting out, and you feel you’re

stumbling across one hurdle

after another. Here are a pick of

our top beginner’s tips.

I’ve lost my file

It’s a common problem for

those new to saving and

organising files – not knowing

where they saved them. If you

can remember what you called

it, switch to the Finder and use

Find on the File menu to open

Sherlock and type it in. If not,

and you’re still in AppleWorks,

try saving another file and note

the folder AppleWorks starts at

in the Save dialog. Chances are,

that’s where your first file is.

I can’t see my document

You’ve got several documents

open, so how do you switch to

the one you want when you

can’t even see it? You can either

choose it from the Window

menu or use the same menu’s

Stack Windows command to

rearrange them so that the title

bars of all of them are visible.

I’ve made a mistake!

No problem, as long as you act

straight away. Whether you’re

word processing, painting,

drawing, spreadsheeting or

whatever, choosing Undo on

the Edit menu (or Command, Z)

undoes your last action.

How do I ‘float’ pictures?

If you’ve pasted a picture as an

inline graphic in your text when

you really wanted it to float as

an independent object, all you

need to do is select it with the

Pointer tool, cut it (Command,

X) and, ensuring the Pointer

(not the Text tool) is active, hit

Command, V to paste it again.

My data’s vanished and
all I’ve got is a row of
hash (#) symbols!

It’s only because the column’s

not wide enough to

accommodate the number.

Widen the column and the

problem’s solved.

My cash calculations
won’t work!

If you get a ‘#VALUE!’ alert, it’s

because you haven’t used a

proper number. We’re willing to

bet it’s because you’ve typed in,

say, ‘£54’ in your cell instead of

‘54’. You need to use the

Currency format for that cell –

AppleWorks will then insert the

‘£’ automatically.

Where have all my
records gone?

If your database appears to

have lost most of its records, its

because you’ve carried out a

Find. Look at the navigator

gadget at the top of the toolbar.

If it’s displaying ‘Records: 3

(34)’, for example, it means it’s

currently showing 3 records

only, out of your total of 34.

Choose Show All Records from

the Organise menu.

Where’s my summary?

More advanced users will want

to experiment with Summaries

and Sub-summaries… and then

wonder why they simply don’t

work. It’s because they won’t 

be visible unless you view 

your database in Page View

(Window menu).

My text won’t resize!

Text doesn’t behave like

ordinary shapes in drawings.

When you resize a text box,

that’s all you’re doing – making

the box bigger. The only way to

make the text a different size is

to choose a new point size from

the pop-up on the Button bar.

How do I circle things
without covering them
up completely?

It’s something a lot of people

want to do, highlighting a

figure in a spreadsheet or a

comment in text, maybe. And

yet if you draw a circle or a

rectangle, it simply covers up

what’s underneath. To draw a

transparent shape of any kind,

all you have to do is open the

Fill Pattern pop-up and choose

the first (transparent) square.

My bitmaps look jagged

AppleWorks’ paint tools are

pretty basic, and it’s difficult to

produce smooth-edged shapes.

One solution is to select the

whole image and choose Blend

from the Transform menu to

apply a softening effect.

My painting’s the 
wrong size!

If you mean the background

‘canvas’ is the wrong size, you

can fix that via the Document

window (Format menu). If you

mean it’s the wrong size when

you use it in a word processor

document, say, then the easiest

solution is to save it, open it as

a drawing (see the File Types

pop-up in the Open dialog)

then copy and paste it into your

final document. You can resize

it just by dragging on the

corner handles. 

For more detailed size and

resolution changes, though,

you’re going to need to open it

in a separate image-editor like

Adobe PhotoDeluxe.

Phew! 15 pages of hard work and it’s still possible that you’re having problems. Don’t fret
- so do the best of us. Here are some tips for helping you out of sticky situations

Applications
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Troubleshooting tips

T

If you get stuck, just click on the
Help menu and choose Help
Contents or Index. The online help
works both as a manual and a
troubleshooting guide, and also
explains many common concepts

Five things to try next

Customise your Button bar. You

can record macros in AppleWorks

to automate routine tasks like

typing in your postal address, for

example. And you can design

your own buttons and assign

macros to them, even creating

your own custom button bars.

Create a slideshow. If you set up

a drawing with multiple pages,

you can then get AppleWorks to

‘play’ each page in sequence to

produce really rather

sophisticated presentations.

Check it out in the online help.

Book marks and hyperlinks.

You can set up Bookmarks for

quickly going to spots in your

documents. You can add lines to

text or graphical objects, too, so

that clicking on them takes you to

these Bookmarks, or even

Bookmarks in other documents.

Libraries and clippings.

AppleWorks 5 calls them libraries,

in AppleWorks 6 they’re

clippings. Either way, it’s where

you’ll find the clip-art images

supplied with AppleWorks, and

where you can store your own

regularly-used text and graphics

for easy access later.

Create a Web page. AppleWorks

can export word processor

documents as formatted Web

pages, automatically converting

any graphics used to JPEG or GIF

images. A proper Web page

editor like PageMill is more

sophisticated, but AppleWorks

sure makes it easy!


